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Introducing DBArtisan

Introducing DBArtisan

DBArtisan is an industry-leading database administration solution for managing Oracle,
Microsoft SQL Server, Sybase, PostgreSQL, IBM DB2, and MySQL databases. Its cross-
platform capability allows users to efficiently manage heterogeneous database platforms
easily using a single front-end tool. Using DBArtisan, users boost their productivity by
using a single tool for all their databases, regardless of the vendor.

About DBArtisan

Your new application provides tools that can be used by a number of functions within an
organization using DBMS from multiple vendors, in testing, development, or production
environments.

Datasource and Server Management: Datasources must be registered. Datasources
can be registered manually or semi-automatically. Storage can be registry-based or file-
based, and a network storage option facilitates shared use of datasource catalogs.

Object management tools: Your application supports a wide range of database objects
and related elements for each DBMS. You can create new obijects, edit existing objects,
and use a range of object operations that support common, general or DBMS-specific
actions.

Coding Environments/Editors: Fully-featured environments dedicated to SQL, DDL
and Active Script development are provided. Execution options are available as
appropriate, and environment-specific related features, such as rollback/commit and
query plan options, are provided. Related coding aids include on-the-fly semantic and
syntactic validation, text substitution shortcuts, and visual query building tools. Related
execution tools include script and file execution facilities.

Schema and data utilities (DBArtisan only): Schema extraction, migration, and
publication wizards let you quickly extract and move schema and data across
environments and even across DBMS types. DBMS-specific import/export, load/unload,
and backup/restore utilities are also available. A Data Editor lets you edit your tables in
real-time, supports all editable datatypes, and provides Unicode options. Table data can
also be imported from formats such as spreadsheets.

Project Management, Version Control, and Script Library: Database project
management facilities help you organize, alter, and keep track of changes to database
objects or SQL scripts. The project management facilities act as a repository to maintain
all source code for a database project. DBArtisan also incorporates version control
functions and build management facilities to help you manage and build projects.

Other Time-savers and Productivity Tools: Working within the DBArtisan environment,
you have access to database and file search facilities, use the visual difference to
compare files or database objects, and access the Microsoft Windows task scheduler.

License-specific Add-ons: Depending on the licenses you purchased, you have access
to the following tools:
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o The DBArtisan Analyst Series includes advanced space, capacity, performance
and backup management capabilities. They let you predict and prevent storage-
related problems, trend data and object growth over time, and pinpoint
performance bottlenecks.

o Debuggers, available for IBM DB2 for Linux, Unix, and Windows, Oracle, Sybase,
and SQL Server, let you test functions and procedures. A Profiler is available for
Oracle datasources.
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Technical Requirements

Technical Requirements

Before using DBArtisan, please verify that your environment meets the requirements
listed below:

Note: Users need full registry privileges during the installation and access
to the keys under HKEY _CURRENT_USER in the registry after installation.

Browser Requirements

DBArtisan requires Microsoft Internet Explorer 11 or later.

Hardware Requirements

Embarcadero Technologies recommends the following minimum hardware
requirements:

o Pentium 4-level processor
o 1 GB of memory

o 1 GB of disk space

o 1024 x 768 display

Operating System Requirements

DBArtisan supports the following operating systems:
o Windows XP SP" (32-bit and 64-bit)
o Windows Vista (32-bit and 64-bit)
o Windows 7 (32-bit and 64-bit)
o Windows 8 (32-bit and 64-bit)

XP Support Notes

Windows XP has two user security groups: Users and Power Users. Microsoft
intentionally does not grant members of the Users Group the authority to install
applications or make global changes to the system. Restricted Users are members of the
Users Group. Standard users belong to the Power Users Group. Microsoft grants
members of the Power Users Group the authority to install programs. You must be a
member of the Administrators Group to install and use Embarcadero Technologies
applications. Because Restricted Users are members of the Users Group, they cannot
install and run Embarcadero Technologies applications.

Use the Group Membership tab to determine your group and review the Microsoft
security guidelines. On the Control Panel, open User Accounts. On the Users tab,
select a user and then click the Properties button. Click the Group Membership tab.
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Vista and Windows 7 Support Notes

Windows Vista UAC and Windows 7 provide two user types: Standard users and
Administrators. DBArtisan can be installed or uninstalled by an administrator or by a
standard user using an administrator token. Standard users can run DBArtisan. For the
purpose of running DBArtisan, default standard user token privileges should not be
modified. Modifying standard user token privileges can result in licensing issues that will
prevent DBArtisan from operating correctly.

32-bit versus 64-bit Application Considerations and
Restrictions

If you install the 64-bit version of DBArtisan, and you are using custom drivers, you must
be using 64-bit versions of those drivers when using the 64-bit version of DBArtisan.
Similarly, 32-bit versions of custom drivers must be used with the 32-bit DBArtisan
installation.

For version control integration, if you install the 64-bit version of DBArtisan, you can
work with either a 32-bit or 64-bit MSSCCI provider. The feature is controlled from the
Options Editor's Version Control tab (File > Options > General > Version Control).
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DBMS Support and Connectivity
Options
Dedicated Support Connectivity Options

DBArtisan provides dedicated connectivity to a specific version range of IBM DB2 for
Linux, Unix, and Windows, IBM DB2 for z/OS,Microsoft SQL Server, MySQL, PostgreSQL,
Oracle, Sybase, and Teradata databases. The following connectivity options are
provided:

o Native Embarcadero drivers: DBArtisan is packaged with a set of native drivers,
each requiring a DBMS-specific client to be installed.

o JDBC drivers: DBArtisan can connect to a datasource more directly using one of
the packaged, third-party JDBC drivers. No additional connectivity components
need to be installed. One or more third-party drivers, tested against DBArtisan,
are installed with DBArtisan.

The following table provides a summary of resources/requirements for connectivity to
dedicated DBMS platforms. For each platform, it lists supported versions, the client
software that must be installed if using native Embarcadero clients, and the third-party,
Type 4 JDBC drivers packaged with DBArtisan.

Embarcadero Technologies 9



DBMS Support and Connectivity Options

DBMS Supported Versions  Client Required for use Packaged JDBC Source

Platform with native Embarcadero Driver &
drivers License
Apache Hive 0.13.1 Simba Hive ODBC Driver Apache Software license
(Technical (v1.4.13.1013) Foundation -
Preview)* Hortonworks Hive ODBC Apache Hive
Driver (v1.4.08.1008) JDBC v0.13.1

Cloudera ODBC Driver
for Apache Hive
(v2.05.10.1003)

IBM DB2 for v8, v9, and v10 DB2 UDB Client for IBM Data Server -
z/0S Windows 8.0 or later Driver for JDBC
IBM DB2 for Versions 9.0 - 10.0 IBM DB2 LUW Client for |IBM Data Server -
LUwW Windows 8.0 or later Driver for JDBC
Microsoft SQL 2005 (All editions Microsoft SQL Server jTDS Type 4 LGPL
Server including 2005 Express Client Library JDBC Driver for source,
Edition for 32-bit x86 Microsoft SQL license
and 64-bit Itanium & Server
x86-64) Microsoft SQL
2008 Server JDBC
2012 Driver
2014
MySQL 4.x MySQL Connector/ODBC MySQL GPL,
Driver 5.2.x Driver - Connector/J source &
MySQL Connector/ODBC JDBC Driver license
driver 3.51.x Driver
Oracle Oracle 9i, 10g, 11q, Oracle SQL*Net Client Oracle JDBC -
and 12c Thin Driver
PostgreSQL 9.3 minimum PostgreSQL ODBC Driver PostgreSQL BSD,
Specifically-supported (latest version JDBC Driver license
PostgreSQL-based recommended)

database products
include Greenplum,
Pivotal HAWQ, and

BigSQL.
Sybase ASE  Sybase 15.7 - Sybase  Sybase Open Client jTDS Type 4 LGPL,
16 JDBC Driver for source,
Microsoft SQL license
Server
Sybase jConnect
JDBC Driver
Sybase 1Q 12.7, 15.4, 16 SQL Anywhere ODBC Sybase jConnect -

drivers for Sybase I1Q 12.7 JDBC Driver for
Sybase 1Q 32-bit ODBC Sybase I1Q
drivers
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Teradata 13.10, 14.0, 14.10, and Teradata ODBC driver for Teradata JDBC -
(Technical 15.0 Windows (version 15 Driver
Preview)* recommended)

* About Technical Previews - Technical previews are intended to
introduce a new DBMS platform only. The available functionality is
typically minimal. For example, command Line startup, standard
datasource registration and connection features, limited Datasource
Navigator/Explorer tree functionality, a minimal set of object actions, as
well as SQL Editor execution and related, common SQL Editor
functionality such as Query Options, Paste SQL Syntax, and Paste SQL
Statement. Access may not be covered under SE or trial licenses. Contact
Oz.Basarir@embarcadero.com to obtain a separate license for a platform
designated as a Technical Preview.

Embarcadero Team Server 2016 Support

DBArtisan can make use of datasource definitions stored on an Embarcadero Team
Server 2016.

Generic JDBC/ODBC Connectivity

Generic JDBC/ODBC connectivity to non-dedicated DBMS systems or non-database
datasources is also provided. DBArtisan can connect to a datasource using a customer-
provided, third-party JDBC version 4.0 or ODBC version 3.0 driver. Minimal DBArtisan
functionality is provided, including a basic Explorer tree and SQL querying.

IBM DB2 for Z/OS Stored Procedure Requirements

When working against an IBM DB2 for z/OS data source, DBArtisan relies on the
following stored procedures, provided as an optional installation step in setting up the
DB2 subsystem:

o DSNWZP

o DSNUTILS

o ADMIN COMMAND DSN
o ADMIN COMMAND DB2

Prior to using DBArtisan against an IBM DB2 for z/OS data source, ensure that these
components are installed on the server. See IBM DB2 for z/OS documentation for more
information.
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Specifically-tested JDBC/ODBC Connectivity
Products: Apache Hive/Hadoop

DBArtisan has been successfully tested against Apache Hive/Hadoop datasources using
the Hortonworks ODBC driver. Similarly, Cloudera Impala datasources have been tested
using the Cloudera JDBC driver. In both cases, SQL querying and a Datasource
Navigator/Explorer tree are available.

DBMS Versions no Longer Supported

As of this release, DBArtisan is no longer being tested against Sybase ASE versions
before 15.7.
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Installing and Licensing DBArtisan

Installing and Licensing DBArtisan

Before you can register any Embarcadero Technologies application, you must meet the
minimum technical requirements. If you meet all the minimum technical requirements,
you can install DBArtisan. After installation, you must license the application.

The following topics walk you through this process:

o Technical Requirements

o DBMS Support and Connectivity Options

o Installing DBArtisan

o Licensing Your Product
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Installing DBArtisan

To install the application successfully, you must complete each panel of the installation
wizard. 64-bit and 32-bit versions of DBArtisan are available with the trial version, which
can be downloaded from http://www.embarcadero.com/products.

The DBArtisan installation wizard installs all corresponding files on your machine. The
installer offers common options such as license agreement, file and folder selections,
and shortcut options. An application-specific option lets you associate file suffixes of
elements such as SQL scripts with DBArtisan.

NOTE: Before installing DBArtisan from Embarcadero ToolCloud, see
http://docs.embarcadero.com/products/xe/ for additional requirements
or revised instructions.

The panels presented by the wizard vary depending on whether you are upgrading or
performing an initial installation.

Caution: If you have not registered a license when you start a DBArtisan
installation, you will be prompted to register a license. For more
information, see Licensing Your Product.

After the installation is complete, we recommend that you reboot your machine before
using DBArtisan.
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Licensing Your Product

Each Embarcadero client application requires one or more licenses to run. An
Embarcadero product, such as DBArtisan, has a baseline license that provides basic
feature support for that product. Also, incremental licenses may be required to support
specific DBMS platforms, product add-ons, or other functions.

For more information, see the following topics:

o

o

Licensing Overview

Licensing Your Application

Selecting a License Category During Startup

Online/Offline Mode and Concurrent License Checkout
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Licensing Overview

Licensing Overview

The following topics provide a high-level discussion of key licensing topics and directs
you to sources of more detailed information.

o Viewing Your License Type and Modules

o Understanding Trial, Workstation, and Networked Licenses

o DBArtisan License Modules, DBMS Support, and Feature Availability

o DBArtisan XE License Modules, DBMS Support, and Feature Availability

o Directing Queries Regarding Licenses

Viewing Your License Type and Modules

The About... dialog, available from the Help menu, displays your license type and each
license module currently registered.

Understanding Trial, Workstation, and Networked
Licenses

Three kinds of licenses are available: Trial, Workstation, and Networked.

Trial licenses A license for a 14-day, full-featured trial version of the product. The trial license
must be registered before you can use the product.

Workstation A license or set of licenses is tied to a particular workstation. The product can
licensing only be used on that workstation.

Networked  Networked licenses are administered and distributed by a central License Server

licensing (Embarcadero License Center or Acresso FLEXnet Publisher). There are two
types of networked licenses: Concurrent and Networked Named User. With
Concurrent licensing, users on different machines take turns using licenses from
a shared pool. With Networked Named User licensing, licenses are pre-assigned
to specific users setup on the license server's user list. Those users are
guaranteed to have licenses available any time. NOTE: Concurrent licenses can
be borrowed for use without a network connection. For details, see
Online/Offline Mode and Concurrent License Checkout.

For a detailed description of licensing options, see
http://www.embarcadero.com/software-licensing-solutions.

DBArtisan License Modules, DBMS Support, and
Feature Availability

Individual license modules correspond to the DBMS platforms you are licensed to use.
Also, each DBMS license module corresponds to a product edition. Feature availability
for each license module edition is as follows:
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o Standard: Provides baseline support including datasource management, object
management, SQL editing and execution, and standard tools and utilities.

o Professional (DBArtisan): Standard Edition features plus SQL Debugger and SQL
Profiler.

o Workbench (DBArtisan): Professional Edition features plus Performance Analyst,
Space Analyst, and Capacity Analyst.

DBArtisan XE License Modules, DBMS Support, and
Feature Availability

An XE license provides access to all supported DBMS platforms. XE module and feature
availability are as follows:

o XE Pro (DBArtisan): Provides baseline support including datasource
management, object management, SQL editing and execution, and standard
tools and utilities, SQL Debugger and SQL Profiler.

o Analyst Pack (DBArtisan): Provides access to Performance Analyst, Space
Analyst, and Capacity Analyst.

Directing Queries Regarding Licenses

Questions regarding license availability, feature availability, and client or server
licensing, should be directed as follows:

o If you work in an organization that uses networked licensing, direct any questions
to your site’s DBArtisan administrator.

o If you are using workstation licensing, direct licensing questions to your
Embarcadero Technologies representative.
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Licensing Your Application

See the following topics for details on registering your product:

o Reaqistering a Trial or Workstation License during Installation

o Reqistering a Workstation License After Application Startup

o Reaqistering By Phone

o Reqistering a Networked License

Registering a Trial or Workstation License during
Installation

Shortly after initiating the download of a trial version of an Embarcadero product, you
should receive an email with a serial number you must register during installation.
Similarly, if you purchase an Embarcadero product while no trial version is active, you will
receive a serial number that must be registered during installation.

1. Start the installation. An Embarcadero License Registration dialog appears.
2. Copy the serial number from the email and paste it in the Serial Number field.

3. Enter your Embarcadero Developer Network account credentials in the Login or
Email and Password fields. If you have not previously created an EDN account or
have forgotten your password, click | need to create ... or I've lost my
password.

4. Click Register.

Your activation file should be downloaded and installed automatically. If this does not
happen, click the Trouble Connecting? Try Web Registration link and follow the
prompts. If you still have problems, see Registering By Phone.

Registering a Workstation License After Application
Startup

The following instructions assume that you have received a workstation license by email
and that you currently have a valid trial license. If you did not install a trial version or the
trial period has expired, follow the instructions in Registering a Trial or Workstation
License during Installation instead.

1. On the Help menu, select About, and then on the dialog that opens, click
Manage to open a license manager dialog.

2. On the Serial menu, select Add.

3. Copy the serial number from the email and paste it in the Add Serial Number
dialog, and then click OK.
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4. Right-click on the serial number you added, and then select Register from the
context menu. A registration dialog opens.

Note: The Registration Code box shows a machine-specific identifier required with
other registration methods.

5. Ensure that the Register using Online Registration radio box is selected.

6. Provide Developer Network credentials in the DN Login name or Email and DN
Password boxes. If you have not previously created an EDN account or have
forgotten your password, click | need to create ... or I've lost my password.

7. Click Register.
8. If prompted to restart the application, click Yes.

Your activation file should be downloaded and installed automatically. If this does not
happen, click the Trouble Connecting? Try Web Registration link and follow the
prompts. If you still have problems, Registering By Phone.

Registering By Phone

If you have problems with either of the above procedures, you can register licenses by
phone. You will have to provide:

o Developer Network credentials

o The registration code displayed in the Embarcadero License Registration dialog
that appears when you start an unlicensed application

o The product base license serial number
o The license serial numbers for any additional features you have purchased.

For North America, Latin America, and Asia Pacific, call (415) 834-3131 option 2 and then
follow the prompts. The hours are Monday through Friday, 6:00 A.M. to 6:00 P.M. Pacific
time.

For Europe, Africa, and the Middle East, call +44 (0)1628-684 494. The hours are Monday
through Friday, 9 A.M. to 5:30 P.M. U.K. time.

Shortly after phoning in, you will receive an email containing an activation file. Then do
the following:

1. Save the file to the desktop or a scratch directory such as c: \ temp.

2. On the Help menu select About and then on the dialog that opens, click
Register. A registration dialog opens.

3. Select the | have received an activation file (*.slip or reg*.txt) radio box.

4. Click the Browse button and use the Select License Activation File dialog to
locate and select the activation file you installed.
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5. Click the Import button to import the activation file and when complete, click the
Finish button.

6. If prompted to restart the application, click Yes.

Registering a Networked License

If you work in an organization using Networked licensing, an administrator, department
head, or someone performing a similar function will provide you with an activation file.

Once you receive the file, save it to the license subfolder of your product’s main
installation folder (typically c: \Program
Files\Embarcadero\<product><version>\1license\), then restart the application.

No additional steps are necessary.
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Selecting a License Category During
Startup

During startup, if multiple concurrent license categories are available, you are prompted
to select a category to use for this DBArtisan session. Multiple license categories can be
set up to provide differing feature access or access to different DBMS versions. Feature
and DBMS version access are typically distributed across multiple license categories to
optimize the use of a site’s purchased licenses.

Note: This dialog also includes the option to remember your selection on subsequent
startups. If you select that option, you can subsequently use the Select Licenses button
on the About... dialog (Help > About) to select a different license.

Contact your License Administrator for details on individual license categories or
requests for additional feature or DBMS support.
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Online/Offline Mode and Concurrent
License Checkout

Concurrent licenses can be used in both online and offline modes. In online mode, you
must have a continuous network connection to your License Center. Licenses are
checked out on startup and checked back in on shutdown.

You can also use a license in offline mode. When you explicitly check out a license for
offline use, you can use the license without a connection to your License Center for a
specified duration. This lets you work while travelling or commuting, work away from
your primary work area, or use the license when a network connection is unavailable or
not required.

Note: Contact your site administrator for information on offline license availability, the
maximum duration, offline license policy at your site, or any other issues arising from
online license usage.

To check out a license for offline use:

1. On the Help menu, select Checkout License. The Check Out Licenses For
Offline Use dialog opens.

2. Select the check box associated with each individual license you want to check
out.

3. In the Checkout Duration box, type the number of hours that you can use the
offline license without a network connection to the License Center.

4. Click OK.
You can work offline for the specified duration. The duration period begins immediately.

If you subsequently establish a network connection to the License Center before the
license duration expires, you can indicate to the License Center that the offline license is
no longer required.

To indicate that an offline license is no longer required:
1. On the Help menu, select Checkin License.

There is no interruption in DBArtisan usage. The license is not actually checked in until
you shut down DBArtisan.
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DBArtisan Tutorial exercises

The exercises that follow walk you through DBArtisan’s major functional areas. After
completing these exercises, you will have the foundation you need to explore the many
features and benefits of DBArtisan. You'll have learned how to competently manage the
major database administration disciplines using DBArtisan’s standard cross-platform
console. Also, you will have a solid understanding of DBArtisan’s more advanced Space,
Performance, and Capacity management capabilities.

This guide is divided into 10 sessions:

o Session 1: Getting Started with DBArtisan

o Session 2: Object and Schema Management

o Session 3: Database Security Management

o Session 4: Space Management

o Session 5: SQL Management

o Session 6: Job Management

o Session 7: Data Management

o Session 8: Performance Management

o Session 9: Capacity Management

o Session 10: General Utilities and Tools

o Session 11: Using Performance [Q

You can use this basic tutorial as a roadmap of product highlights, but also to help you
find your own path to explore DBArtisan.

Once you've started, you can select Help Topics from the Help menu to find many
additional resources that complement and build on many of the activities shown in this
tutorial.
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Session 1. Getting Started with
DBArtisan

Your first tasks in getting familiar with DBArtisan are as follows:

o Starting the DBArtisan Application

o Reaqistering Cross-Platform Datasources to DBArtisan

o Setting up the Datasource Explorer

o Exploring General Usability Features
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Starting the DBArtisan Application

Starting the DBArtisan Application

How you start DBArtisan depends on the type of application you are evaluating:

o InstantOn version: start the application by double-clicking the file you
downloaded.

o Fully-installed version: The Start menu sequence for DBArtisan is always in the
form Programs > Embarcadero DBArtisanversion identifier> DBArtisanversion
identifier, where version identifier reflects the version you are running.

To get started
1. Run DBArtisan.

The first time DBArtisan starts, a dialog opens, prompting you to set up datasources. In
addition to letting you manually set up individual datasources, a number of more
automated methods are available. If you have installed and used other Embarcadero
tools, DBArtisan can find any active datasources being used by those tools. Also,
DBArtisan provides a Discover Datasources feature that automatically searches the
DBMS configuration files on your system for datasources that are not currently
registered. Since other Embarcadero tools let you export datasource definitions to file,
you also have the option of importing these definitions.

2. For the purpose of this tutorial, click Cancel. You will be registering a datasource
manually.

Proceed to Registering Cross-Platform Datasources to DBArtisan.
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Registering Cross-Platform
Datasources to DBArtisan

The Datasource Registration Wizard walks you through the process of registering a
datasource for use with DBArtisan.

1. On the Datasource menu, select Register Datasource. DBArtisan opens the
wizard, initially prompting you for the DBMS type.

2. Select Oracle as the database type and then click Next. DBArtisan opens the
next panel of the Datasource Registration Wizard.

-

Register Datasource 2

Information
Please enter the connection information for the Oracle server. You can either select an entry
from your TNSNames.ora file, from an LDAP server or enter the information manually.

I I S
| Database Type ) - -
| Connection Infarmation | Registration type: ‘ User defined -

Security Parameters

Custom Driver Prope

Host: | |

Port: 1521

Datasource Group SiD/ServiceName: [ ] Type: (©) SERVICE_NAME () SID

Instance Name:

Datasource Name: | |

Test Connection < Back MNew Firist Cancel Help

3. Ensure that User defined is selected and provide the Host machine name
associated with an Oracle datasource.

4. Type a Port number. The default is 1521, but you can change it to wherever the
Oracle listener is set up.

5. Specify a Type of SERVICE_NAME or SID and enter the corresponding value in
the SID/Service box.

6. Inthe Datasource Name text box, type SAMPLE_DATASOURCE for the
purpose of this example.

7. Click Next. DBArtisan saves your selections and opens the next panel of the
wizard. This is where you enter login credentials.

8. Provide a User ID and Password.

9. To save and encrypt your password so that you do not have to provide
credentials each time you connect, select Auto-Connect?.

10. Click Datasource Group to display the last panel.
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11. In the Managed Datasources tree, select the folder corresponding to the type
of DBMS you are registering.

12. Click Finish. DBArtisan prompts you as to whether you want to connect to the
datasource.

13. Click Yes.

The same easy-to-use Datasource Registration Wizard is available for directly-supported
DBMS platforms as well as JDBC and ODBC datasources. Datasource information is
stored in the registry, is editable, and datasources can be deleted. If you run multiple
Embarcadero products on the same machine, they can share the same datasource
catalog.

A number of datasource catalog storage options are available:

o Alocal, file-based alternative lets you easily move a datasource catalog between
users.

o Aremote, file-based alternative lets multiple users share a single catalog.
Settings can be changed locally but are not propagated to other users or
retained over shutdown/startup

Another way of centralizing datasource definition maintenance is available if you use
Embarcadero Team Server 2016. Datasource definitions can be stored on Team Server
2016 and subsequently registered as local datasources. Local connection details for a
datasource are synchronized with the Team Server 2016 version on each attempt to
connect to a datasource.

For details on datasource options, refer to the DBArtisan online Help.

Proceed to Setting up the Datasource Explorer.
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Setting up the Datasource Explorer

The first time you start DBArtisan, the Datasource Navigator occupies the left side of the
main window. It is a single pane window that lets you navigate the datasources that you
register and initiate actions against databases and database obijects.

Datasource Navigator o X
L@ ¥
[ DB2 Servers
[ Interbase-Firebird Servers
[ JDBC Servers
[ MS SQL Servers
(3 MySQL Servers
o My_Custorm_Group
[ Oracle Servers
[ Servers
[ Sybase Servers

For the following set of exercises, you will be using a similar aid.
To prepare for subsequent exercises

1. Dismiss the Navigator by clicking the close button (X) at the top of the Navigator
window.

2. Select View > Activate Explorer.

The Datasource Explorer is a two pane window that provides most of the same functions
as the Navigator.

je —\‘,L ROMLABORCL11g_2 - Storage

- [ MS SQL Servers -
- [ MySQL Servers Control Files
3 My_Custom_Group . | LB Directories

4 [ Oracle Servers
4 ﬁ ROMLABORCL11g_2 (Oracle 11.1.0.7.0
- 97 Filters

» % Instance

& Storage
&7 Security
Ad Scherna

EJ Performance
. Bl ROMI ARNRC 110 2 fOvacle 11201 0 v | 3 Item(s) ’ ’

% Redo Log Groups
e] Rollback Segments
[E3Tablespaces

m
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One key difference is the right pane of the window. It displays details for the node
currently selected in the left pane. This might be individual database objects such as
tables or primary keys, configuration parameters, and so on.

Before proceeding, familiarize yourself with the View menu commands for opening the
Navigator and Explorer, and the ways to close those windows. As you proceed with
DBArtisan, you will develop a preference for either the Navigator or Explorer, or find
that each has benefits that are preferable in different situations.

Proceed to Exploring General Usability Features.
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Exploring General Usability Features

Exploring General Usability Features

DBArtisan provides many “user in mind” features that make the product configurable to
meet individual needs and preferences. These features are designed to shave time off
the tasks that you perform many times on any given working day.

Retaining Datasource Explorer View Settings

1. Atthe top of the Explorer tree, click to expand the drop-down menu.

() DB2 Servers

() Interbase-Firebird Servers
. [C) JDBC Servers

[ MS SQL Servers

[3) MySQL Servers

[3) My_Custom_Group

[3) Oracle Servers
. [ Servers

[3) Sybase Servers

2. Select Retain View Settings.

Organize by Object Owner

Show System Objects »
Show Only My Objects »
Full Refresh

Expand All Groups
Collapse All Groups

Collapse All Datasources
Retain View Se[:;’)ngs

Bookmarks »

The next time you open DBArtisan, the Explorer appears just as you left it.

Working with Datasource Explorer Bookmarks

1. Inthe Explorer tree, right-click the datasource you registered and select Add

bookmark from the context menu.
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Clm| SAMPLE_DATASOURCE ((~=cl=ttainians 0
' Connect

Change Group...
Edit
Unregister

Reqister Like

Monitor

Configure...

9 o MM R 7 @

Extract

o® 8

Migrate...

Command >

Refresh
Filter. ..
Copy object name(s) Ctrl+C

| Addbogkmark H

DBArtisan opens the Add Friendly Bookmark Name dialog.
2. Click OK.

After Bookmarks are defined you can use them to easily navigate to commonly used
datasource resources using the dropdown at the top of the Explorer and selecting the
Bookmarks item.

Bookmark Manager...

Orace |\ >|5 Datasource: SAMPLE_DATASOURCE

&

Setting Keyboard Shortcuts and Hotkeys
1. From the Tools menu, select Customize. The Customize dialog opens.

2. In the Customize dialog, open the Keyboard tab.

Embarcadero Technologies 31



Exploring General Usability Features

(Customiz'e
Toolbars] Tools I Options] &pplication Visual Style  Keyboard I
Cateqgory: Set Accelerator for: .
|Fi|e _VJ |Defau|t _V_]
Commands: Current Keys:
P e }A;
Active Script (7l
Close |
DDL Editor...
Exit 1
IS0l (el Press New Shortcut Key: Reset Al |
Description: |

Close

The Keyboard tab can be used to set keyboard shortcut hot keys for all areas of
DBArtisan functionality.

3. Click Close.

Datasource Explorer tree filtering

DBArtisan provides a number of ways to filter the Datasource Explorer tree, easing
navigation. During a DBArtisan session, you can use the Filter box at the top of the
Datasource Explorer to display only those objects whose name contains characters
typed in the Filter box.

=0 X

=) MS SQL Servers
- fm) TORLABSQLOB_1 (SQL Server 10.00.16
+- B Filters
+ % Server
+ - Storage
+- ¥ Security
+ £} Databases
+- B2 Performance
—-[) Oracle Servers
=l % TORLABORCL11g_2 (Oracle 11.1.0.6)
- Ad schema
+-Ad CODRUTA
+-Ad COSTIN
-4 SCOTT
=71 Sybase Servers
= (s TORLABSY15_2 (Sybase Adaptive Serv
—I-r't} Databases (45)
- [ codruta
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If you are interested in a more permanent filtering method, you can create filters at the
DBMS or datasource level. Filters are available under the Filters node for each
datasource.

RLADOL
=B Filters (4)
- []®" Ignore System Objects (0)
—[[]®" show Only My Objects (0)
- [¥] 9 oraclez (0)
Y197 new Filter (0)

It I+ @ Storage

Right-clicking in the tree and selecting Filter opens the Filters dialog. It lets you filter
out object types at the DBMS platform level. It also lets you create obiject filters.

Obiject filters can be object name-based, schema-based, or some combination thereof.
A name-based or schema-based filter consists of one or more ANDed conditions. You
also specify the object types to which the filter is to apply.

r »
_5 7 Object Filters W E

£}y DB2
=¥ DB2 205 | New ‘
 #-[[]® 1gnore System Objects

~ #-[]®" Show Only My Objects | Delete |
[ - [V]oF myFilter | Rename |
'ty Oracle

= M5 SQL | Clone |

#-[]®" Ignore System Objects View

- #-[]® show Only My Objects OBy Datasourcs
e MySQL | :

=} Sybase (¥ By Filter

oK H Cancel || Help

|

Obiject filters are created at the DBMS or datasource level and can be enabled and
disabled for individual datasources.
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The Filters dialog also lets you hide or display nodes based on object type. Node
filtering lets you filter out object types for all datasources of the same DBMS type.

4 Node Filters I B

: 't} DBz Z0s ‘
=} Oracle
- [V]® Filters ‘
[+ % Instance
=-[¥] & storage
Control Files
l-g Directories
2 Redo Log Groups
Rollback Segments
Tablespaces
+-[V] A Security
+-[v] & schema
+-[V]E3 Performance
- MS SQL
- MySQL
+-r'F Sybase

ok || Cancel || Heb

In addition to any custom obiject filters you create, the Filters node also provides access
to two default filters: Ignore System Objects and Show Only My Objects. They can be
applied at the datasource level and cannot be deleted or modified.

Proceed to Session 2: Object and Schema Management.
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Session 2: Object and Schema

Management

DBArtisan provides unparalleled database object management capabilities. Its database
platform-specific and version-specific graphical object editors and wizards enable you to

easily create, drop or alter any of your accessible database objects.

Creating a Table Object

The following example walks you through creating a standard Oracle table object. This
concept carries across all of the supported object types, across all of the supported

platforms.

1. On the Datasource Explorer, expand the Schema node of an Oracle datasource.

2. Right-click the Tables node, and then select Create.

3. DBArtisan opens the Table wizard and leads you through the process of creating

a table object.

Create Table Wizard - Step 1 of 10

FX)

Properties
Specify the table properties.

Properties

Property

=) Creation
Schema
Name

= Table
Cache
Row Movement
Parallel Degree
Parallel Instances
Percent Free

= Physical
Row Organization
Logaing
T able Compression

Value

a2

o |

HEAP

]
O

| LCancel ||

Help

4. Complete the wizard panels, and ensure that you create two or more columns in

the table.
5. Click Finish.
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DBArtisan lets you preview any and all generated scripts before you submit them to the
database. This is standard for all object-related scripts.

Making changes to an existing table object

Changes to database tables, such as modifying column lengths, inserting new columns,
or deleting unneeded ones, can require dropping off a table. This requires knowledge
of the underlying object dependencies so that these dependent objects are rebuilt after
the table has been recreated. DBArtisan provides the ability to perform “extended”
table alterations by constructing an SQL script with the steps necessary to save off the
original data, create the new table, and populate it with the original data. Once these
steps are complete, all dependent objects are then rebuilt and permissions re-applied.

1. From the Explorer, Tables node, select the table you created in the previous
example.

2. Double-click the table or from the Command menu, click Open.

DBArtisan opens the Table Editor. The Table Editor provides access to basic table
properties, the list of table columns as well as any constraints, storage parameters, space
allocation, partitioning, table dependencies, object privileges, table DDL and other
attributes of the table.

3. Ensure that the Columns tab is selected and select one of the columns you
created in this table you want to modify.

Details for the column are shown in the Column Attributes area on the right side of the
pane.

4. In the Width or Scale text box, type a new value.
5. On the Table Editor toolbar, select the Alter button.
DBArtisan lets you preview the SQL script before you submit it to the database.

6. Close the Table Editor pane.

Working with Object DDL

DBArtisan allows you to easily extract DDL for single or multiple objects using several
methods. The most straight-forward is described here:

1. On the Explorer, right-click the table you created earlier, and then select Extract.

The DDL for all highlighted objects is extracted directly in a DDL Editor where it can be
altered, executed and saved to the database, with no intermediary steps required. For
example:
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@S PO & AR A
CREATE TABLE ADINAF.AAAAAA

(
% "a" NUMBER(6,0)  NULL
)
ORGANIZATION HEAP
TABLESPACE SYSTEM
NOLOGGING
PCTFREE 10
PCTUSED 40
10 INITRANS 1
11 MAXTRANS 255
12 STORAGE(BUFFER_POOL DEFAULT)
13 NOPARALLEL
14 NOCACHE
15 NOROWDEPENDENCIES
16 /

LWONOU S WN =

>

m

Auto Commit Off | | \ROMLABORCL11g_2\system |Linel Coll

2. Close the PL/SQL Editor pane.
Proceed to Session 3: Database Security Management.
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Session 3: Database Security
Management

DBArtisan can help you efficiently establish and maintain database security. Whether
you are managing an existing production database or setting up a new environment,
you'll find consistent support across all of the supported platforms.

Adding a new database user

While this example focuses on creating a new Oracle user, the same wizard-driven
principle applies to all security objects (groups, roles, etc.).

1. On the Datasource Explorer, expand an Oracle datasource, and then the
Security node.

2. On the Security node, right-click Users, and then click Create.

DBArtisan opens the Create User Wizard and leads you through the process of adding

a user.
Create User Wizard - Step 1 of 6 - @
Properties =
Specify user name. é;’
Rroperties Property Yalue
B Creation ol
Name |
E Defaults
Default Tablespace USERS |
Temporary Tablespace TEMP v |-
Profile DEFAULT v
El Account
Identified By REQUIRED_YES v
Password
, C -
[ Cancel ] [ Help ]

3. Provide the information on each panel of the Create User Wizard until you reach
the DDL View panel.

DBArtisan allows you to preview any and all generated scripts before they are submitted
to the database. This is standard for all object-related scripts.

4. Click Execute to create the new user.
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DBArtisan automatically opens the User Editor for the new user. The standard User
Editor can be used to manage existing database users as shown below.

Granting and Editing User Privileges

Privileges can be easily granted, revoked, or viewed from within either of two editors
within DBArtisan; the User Editor, or the individual object editor (Table, Procedure, etc.).
The User Editor provides a tabbed interface, which can be used to view and modify
individual attributes of the user.

1. Inthe User Editor, open the Object Permissions tab.
2. Use the Object Type dropdown to select a set of objects such as tables or views.

3. Right-click a cell (corresponding to a specific object and a specific permission,
such as DELETE), and then click Grant.

A distinctive icon is shown in the cell, indicating that this permission is granted. You use
a similar process to revoke privileges and perform other permission-based activities.

4. On the Object Editor toolbar, click Alter to implement the changes.

Proceed to Session 4: Space Management.
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Session 4: Space Management

Managing space is vital to ensure the availability and performance of your databases.
DBArtisan incorporates many built-in space features that let you smartly manage and
exploit all aspects of your database storage. The following examples walk you through a
review of DBArtisan’s built-in support for reporting Oracle tablespace storage and space
data.

o Built-in Space Management

o Advanced Space Management (Oracle and SQL Server only)
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Built-in Space Management

Built-in Space Management

While this example is specific to Oracle tablespaces, the same concept applies to all of
the supported platforms.

1. On the Datasource Explorer, expand any Oracle datasource.

2. On the Oracle datasource, expand the Storage node, and then select
Tablespaces.

3. Right-click any tablespace listed in the right pane of the Explorer window, and
then click Open.

Embarcadero DBArtisan opens the Tablespaces Editor.

4. Select the Properties tab. The Storage group on that tab provides a summary of
the space settings for the tablespace.

= Storage

LO

5. Select the Extent Details tab. It provides more detail on an extent-by-extent

basis.
Extent details [

‘ VType Name File Ib Extent 1D Block I[V)V Blocks  Bytes *
INDEX SERGIU.UK_DATE 71 0 769 8 65536
TABLE SERGIU.TESTTABL... 71 ] 745 8 65536
TABLE SERGIU.TESTENCR... 71 1] 681 8 65536
TABLE SERGIU.STUDENTS... 71 0 713 8 65536
TABLE SERGIU.STUDENTS... 71 0 729 8 65536
INDEX SERGIU.PK_DATE 71 0 761 8 65536
INDEX SERGIU.PKID_EAFK1 71 1] 737 8 65536

| TABLE SERGIUJOBURI_EA... 71 ] 721 8 65536

6. On the Tablespace Editor, click the Space tab.

The Space tab displays a graphical view of the free and used blocks for the target
tablespace.
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Number of Blocks Distribution of Tablespace Space
Free Blocks 640 5.00MB
Used Blocks 128 1.00MB
Total Blocks 768 6.00MB

@ Free Blocks 83.3%
@ UsedBlocks 16.7%

7. Finally, on the Tablespace Editor, click the Map tab.

The Map tab displays a color-coded map of the objects contained on the tablespace.
The map segments are proportional to the actual size of the objects on the tablespace.

Map
- Space Info - S
Total 200.00MB  Free:  168.88MB | Heomenve | Legend. || Disply.. |
Used: 31.13MB % Free: 84.44 I Fit In Window | Full Screen
~Map
[_»_s;
+ Dbject Demographics
| Name Extents: Block\s‘“é
1 HRWN 1 8 E
2 COSTIN.SYS_LOBODD0347432C00003%% 1 8
3 COSTIN.SYS_C00B86136 21 768 E
4 COSTIN.SYS_C0086135 1 3
E  FASTIN GYS 1L ANAN2A7AQICANNN2¢E 1 a o
(%], T

Note the additional Reorganize and display options.

8. Close the Tablespaces Editor pane.
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Proceed to Advanced Space Management (Oracle and SQL Server only).
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Advanced Space Management (Oracle and SQL Server only)

Advanced Space Management
(Oracle and SQL Server only)

For advanced space analysis and management, DBArtisan’s optional Space Analyst
component contains sophisticated diagnostics to help you pinpoint all space-related
problems in your database, as well as an intelligent reorganization wizard that can
reorganize all or selected parts of your database.

Database Overview ﬁ Tablespace Fragmentation Overview @
Fragmentation Index

[ TABLE (KB) 61,845,312] Storage Percent
I Other 3139,965] (User Objects)

Fragmentation Index

Tablespace(s) |

Tablespace Space Overview @ Tablespace Objects Overview

Total Space Allocation

Tablespace Name Table (MB) Index (MB) Clustelfgﬂ

ABWIDSN 0 0 ]
""""""""""""" AC_AUTO 0.06 0.13
_______________________ ALTER _TABLESPACE_B 0 0
| APPDATA_TBL_RENAM 0 ]
----------------------- ARTISAN 0 0
AUTO_SEG_TS 0 0
"""""""""""" BIGFILE1 0 ]
__________________ BIGFILE1S 0 0
| BIGTBS_01 0 0
—————————————————— (- | CORMELIATS_TEMP 0 0

| CORMELIA_UNDO 0 0 _

| COSTIN 24,63 6.31 [

Tablespce g [ [

Note: Space Analyst is a separately-licensed component. If you are not working with an
evaluation copy of DBArtisan or do not have a specific license, proceed to Session 5:
SQL Management. Contact your license administrator or your Embarcadero
representative about obtaining a license.

To see the sort of information provided by the Space Analyst
1. On the Analyst menu, select Space Analyst.

Note: If prompted to install components on the server, allow DBArtisan to install the
components.

The Space Analyst launches in the DBArtisan workspace.

Embarcadero’s Space Analyst provides sophisticated diagnostic capabilities to
troubleshoot bottlenecks and performance inefficiencies that result in poor space
management. See the DBArtisan online help for a detailed walkthrough of all available
features and functionality.

Embarcadero Technologies 44



Advanced Space Management (Oracle and SQL Server only)

2. Select the Data Files, Tablespace Map, Tables, and Indexes tabs available at
the bottom of the Space Analyst pane.

3. Close the Space Analyst pane.

Proceed to Session 5: SOL Management.
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Session 5: SQL Management

DBArtisan provides powerful visual tools for creating and analyzing complex SQL
statements and server-side code objects. The following examples walk you through
DBArtisan’s Visual Query Builder, feature-rich ISQL facility and some of the advanced
analysis and debugging capabilities provided by the Embarcadero SQL Debugger and
SQL Profiler:

o Working with Query Builder

o ISQL Window
o SOL Debugging, Analysis and Tuning.
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Working with Query Builder

Working with Query Builder

1. From the Tools menu, select Query Builder.
DBArtisan opens the Query Builder.
2. Inthe Tables/Views tab, right-click a table or view and select Add.

3. Inthe window that opens, select the columns to return the result. For example:

Alx|
_I"ROWID"

_IVENDOR_LOAD _ID
MSERVICE NIV

~ORIGIN _CD
JDESTINATION_CD
JLOCKOUT_TIME

AVAILABLE TIME

_IMONDAY TRANSIT DAYS
ITUESDAY TRANSIT DAYS
_IWENDESDAY TRANSIT DAYS
_ITHURSDAY TRANSIT DAYS
_IFRIDAY TRANSIT DAYS
_ISATURDAY TRANSIT DAYS
_ISUNDAY TRANSIT DAYS

Query Builder generates the query text in the lower SQL window.

1 SELECT SYSTEM.ANH. SERVICE NM,
2 SYSTEM. ANH. ORIGIN_CD

3 FROM BYSTEM.ANH

4

5

You can build advanced queries using the options supplied on the DML tab. You choose
the type of query (SELECT, INSERT, and so on) using the dropdown on the Query
Builder toolbar.

4. After the query is built, click the Execute button (green arrow) on the Query
Builder toolbar.

Query Builder displays results in the lower SQL window.

5. Close the Query Builder pane.
Proceed to ISQL Window.
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ISQL Window

DBArtisan offers a fully-featured SQL editor. In addition to basic text processing
features, the editor environment offers testing/debugging and execution facilities. In
combination with supporting features, the ISQL editor eases and speeds up the process
of developing working scripts.

1"y PO UG A R-O(-L B A
1 SELECT * FROM Jobs

Auto Commit Off | | \ROMLABORCL11g_2\system Line1 Col 19

Automated error detection and coding assistance

DBArtisan provides a range of features that detect or help you avoid errors and save
keystrokes in developing your scripts.

To enable these features:
1. On the File menu select Options. The Options dialog opens.
2. In the left-hand pane, expand the ISQL node and then select Code Assist.
3. On the Code Assist panel:
= Ensure that Enable Code Complete is selected.
» Ensure that Enable Real-time syntax checking is selected.

= Ensure that Severity levels for semantic validation problems has
Warning selected.

4. Click OK.
To see these features in action:
1. On the File menu, select New > ISQL.

DBArtisan opens the ISQL Editor window. You can add SQL code via your method of
choice (free-form typing, retrieve from a file, paste copied code, etc.).

2. Experiment with the automated error detection and coding assistance as follows:
= Type SELECT * FROM and stop typing. Note the error condition.
1 SELECT * EROM

" | = 10

By default, DBArtisan runs a syntax check any time there is an interval of 1.5 seconds
between keystrokes. You can also disable automatic syntax checking and only run a
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check when you manually initiate it. Syntax error annotation persists until you correct the
problem.

» This time type a fragment that includes the name of a nonexistent object,
SELECT * FROM NON.OBJECT, for example. For now, ignore any
popups. The warning condition is a result of on-the-fly semantic
validation. DBArtisan notifies you when a script contains a reference to an
object that DBArtisan cannot resolve.

= Type SELECT * FROM followed by a space and then stop typing. If no
popup appears, press CTRL+SPACE. The Code Complete suggestion
box lets you select from objects or object name components such as
databases or schema. This feature saves keystrokes and minimizes typing
errors. See the online help for full descriptions of these features.

3. If you want to disable the automated error detection and coding assistance
features, select File > Options and on the Code Assist page, click Restore
defaults.

Feature Summary

The ISQL Editor window includes the following features and options:

o The ISQL window highlights all platform-specific and general keywords, and
provides options for SQL code formatting and analysis.

o Once the code is executed, you have control over whether your transaction is
committed or rolled back from the database.

o For all open ISQL windows, there are also options for connection locking,
scheduling, executing your code across multiple datasources, explain plan
generation, and SQL Tuning.

Setting environment options

DBArtisan lets you set platform-specific query options to immediately determine if your
code is optimized.

1. Press F8.

DBArtisan opens the Query Option dialog.
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Option Value

= Query Analysis
Network Activity [
Execution Information )
1/O Activity ]
Sort Activity [
Index Activity [
Parse Activity ol
Table Activity [
0S Activity ()
Wait Activity )

=/ Miscellaneous
Batch Delimiter /
Row Count 0
LONG Size (bytes) 8192
Max Emors Before Aborting (0 = off) 0
Check syntax when executing [
Run script with batch execution ¥l

2. Either close the Query Options dialog and then the SQL Editor window or enter
a valid query in the ISQL editor and then execute your query by clicking the
Execute button.

B
3. When complete, ensure that only the Datasource Explorer window is open.

Proceed to SQL Debugging. Analysis and Tuning.
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SQL Debugging, Analysis and Tuning

While this example is specific to Oracle PL/SQL Debugging, the same interface and
functionality applies to all of the supported platforms.

To see debugging in action

1.
2.
3.

4.

On the Datasource Explorer, expand any Oracle datasource node.
On the Oracle datasource, select the Procedures node.

In the right pane of the Explorer, right-click any stored procedure, and then
select Debug.

If prompted, enter any input parameters and then click Continue.

After the SQL Debugger interface is displayed you can step through code, step into
dependencies, set and watch variables, and even perform basic code profiling for each
line of executed code. See the DBArtisan online help for a detailed listing of all available
SQL features.

5.

Experiment with debugging features and then close the debugger window.

Proceed to Session 6: Job Management.
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Session 6: Job Management

DBArtisan freely integrates with the Microsoft Windows Task Scheduler, which allows
you to virtually schedule any task to run on your own computer whenever and how often
you'd like. While this example is specific to an Oracle table redefinition, the same
concept applies to any job or script that can be scheduled.

To schedule a job, do the following:
1. On the Explorer, expand any Oracle datasource.

2. On the Oracle datasource, expand the Tables node, right-click any table, and
select Extract. DBArtisan extracts the DDL that defines the selected table and
opens an ISQL Editor window on the DDL.

3. From the ISQL window toolbar, click the Schedule button.

The Schedule Action dialog opens. You can provide a name, set notifications, and
specify an output directory for the new job.

Schedule Action Dialog

Specify Information for Notification of Job Completion

Job Name:
ISOLS chedulerD81620071127204.M|

Job Description (Email subject line]:
1SALScheduler

EMail Address(es]: (Separated by semi-colons)

Net Send: [Metwork user names separated by semi-colons)

Action Output Directory:
C:ADOCUME~14davidt\LOCALS ~14Temp' -

¢ OK ] [x‘ gancel] ['? Help ]

4. After you have completed the dialog, click OK. The Job Scheduler dialog
opens.

5. Proceed as prompted to schedule your job. When finished, close the ISQL
window.

You can use the Oracle Job Queue explorer node to monitor your job.
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Proceed to Session 7: Data Management.
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Session 7. Data Management

DBArtisan provides comprehensive facilities to help you manage the data in all of your
databases. A visual data editor helps you add, change and delete data from your tables
with all referential integrity enforced. You can create INSERT statements for tables using
current data and also extract data as XML documents for certain databases. Rounding
out its rich Schema Management capabilities, DBArtisan also allows you to migrate
schema objects and associated table data from one database server to another, across
the same or different platforms.

The following topics walk you through some of the data management features:

o Visual Data Editing

o Working with Table Data - Create Insert Statements

o Working with Table Data - Extract Data as XML

o Advanced Data Management - Schema and Data Migration
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Visual Data Editing

To start the Visual Data Editor, do the following:

1. In the Datasource Explorer, right-click any table and select Edit Data. DBArtisan
opens the Data Editor Filter dialog.

2. In Columns, select the columns that are to be included in the editable data.

Data Editor Filter '

Construct a Select Statement to filter data for the Data Editor

Columns:

\[¥]"ROWID"

@A

‘!3 . Clear &l
vIg

\Where:

Select Statement:
SELECT T."ROWID", T.A, T.B, T.C FROM A.ART2 T

|¢ 0K H # Cancel || 0 Help

You can also filter the editable rows by including your SELECT statement.
3. Click OK.

In Live mode, all changes are applied to the database when you move off of an updated
or inserted row. Deleted rows are immediately removed from the database. Batch mode
allows you to make changes and then save all when all are complete. The mode is
controlled by a dropdown in the Data Editor toolbar.

4. Experiment with editing your data, and when complete, on the Data Editor
toolbar, click the Execute (blue arrow) button.

DBArtisan commits your changes. Regardless of mode, all of the generated DML
statements are viewable in the lower SQL window.
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4 4 » ¥ JSs@L' History %

1 -- Statements To Be Executed: |Z|

2 —— S

3 UPDATE A.ARTZ SET ARTZ.B="t' WHERE ARTZ."ROWID"= | _
' AABeTAAABAACQKCAAD" AND ARTZ.A='s ' AND ARTZ.B= |
Tq ' AND ART2.C="k )

4 COMMIT |

5 |

Row S Col 3 5 Row(s)

5. Close the Data Editor pane.

Proceed to Working with Table Data - Create Insert Statements.
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Working with Table Data - Create

Insert Statements

DBArtisan lets you generate a set of INSERT statements based on rows of an existing

table.

1. On the Datasource Explorer, select any Oracle datasource.

2. On the Oracle datasource, expand the Tables node.

3. In the right pane of the Explorer window, right-click any table, and then select
Create Insert Statements. DBArtisan opens the Create Insert Statements

dialog. For example:

Create Insert Statements

Construct a Select Statement to filter data

Select Statement:

[“]Include awner or schema information in Insert statements

[]5et row count

Columns:

|} Add Al
[le —

Jc

ﬂhere:

v |X Cancel || 2 Help

4. In Columns, select the columns you want to include in the INSERT statement.

5. You can also filter what rows are included by adding your WHERE clause.

6. Click OK.

The resulting INSERT statements are created and presented in an active ISQL window.
At this point, they can be executed immediately, scheduled to execute later, or saved.
Note that all extracted INSERT statements can be run against the same or different

databases containing a similar schema.
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—— TABLE INSERT STATEMENTS

INSERT INTO HR.JOB_HISTORY ( JOB_HISTORY.EMPLOYEE ID,
JOB_HISTORY.START_DATE, JOB_HISTORY.END_DATE,
JOB_HISTORY.JOB_ID, JOB HISTORY.DEPARTMENT ID ]}

VALUES ( 113, TO_DATE('11/04/2006 12:43:24 PM',
"MM/DD/YYYY HH12:MI:SS AM"),

TO DATE ("01/15/2007 12:43:24 PM',

"MM/DD/YYYY HH12:MI:SS AM"), 'PU_MAN', 270 )

/

INSERT INTO HR.JOB_HISTORY ( JOB_HISTORY.EMPLOYEE ID,
JOBE_HISTORY.START DATE, JOBE_HISTORY.END DATE,
JOB_HISTORY.JOB_ID, JOB HISTORY.DEPARTMENT ID )

VALUES ( 102, TO_DATE ('01/13/1993 12:00:00 AM',
"MM/DD/YYYY HH12:MI:SS AM"),

TO_DATE ('07/24/1998 12:00:00 AM',

"MM/DD/YYYY HH12:MI:88 AM'"), 'IT PROG', 60 )
/

7. Close the editor pane.

Proceed to Working with Table Data - Extract Data as XML.
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Working with Table Data - Extract
Data as XML

DBArtisan lets you generate an XML representation of table data.
To extract data as XML
1. On the Datasource Explorer, expand any Oracle datasource.
2. On the Oracle datasource, expand the Tables node.

3. Inthe right pane of the Explorer window, right-click any table listed, and then
select Extract Data as XML.

4. Select the columns to include in the SELECT statement.

5. You can also filter what rows are included by adding a WHERE clause in the
Select Statement box.

6. Click OK.

The resulting XML document is created and presented in an active XML Editor. At this
point the document can be saved in XML format.

(3 £] Close

1 <?xml version="1.0"2>

2 [CJ<ROWSET>

3 [ <ROW>

4 <ROWID>AAAHM/ AAFAAAABSAAA<L/ ROWID>

5 <EMPLOYEE_ID>113</EMPLOYEE_ID>

6 <START_DATE>11/04/2006 12:43:24 PM</START_DATE>
7 <END_DATE>01/15/2007 12:43:24 PM</END_DATE>

8 <JOB_ID>PU_MAN</JOE_ID>

9 <DEPARTMENT_ID>270</DEPARTMENT_ID>

10 - </ROW>

11 [H <ROwW>

12 <ROWID>AAAHM/AAFAAAABUAAA</ROWID>

13 <EMPLOYEE_ID>102</EMPLOYEE_ID>

14 <START_ DATE>01/13/1993 12:00:00 AM</START_ DATE>
15 <END_DATE>07/24/1998 12:00:00 AM</END_DATE>

16 <JOB_ID>IT_PROG</JOB_ID>

17 <DEPARTMENT_ID>60</DEPARTMENT_ID>

18 - </ROW>

= Exploreri™, | XML Editor: JOB_HISTORY |

7. Close the editor pane.

Proceed to Advanced Data Management - Schema and Data Migration.
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Advanced Data Management -
Schema and Data Migration

DBArtisan provides advanced data management tools that help you to move schema
and corresponding table data across the same or different platforms. You can copy a
single database object, all objects owned by a specific user, or an entire database, all
guided by a wizard-driven process.

While this example is specific to an Oracle to SQL Server schema and data migration,
the same concept applies to any migration involving any combination of the supported
platforms.

To open the Schema Migration Wizard:

1. On the Utilities menu, select Schema Migration. DBArtisan opens the Migration
Wizard.

2. Select the Perform new migration option.

3. Click Next. DBArtisan opens the next panel of the Migration Wizard. For

example:
Migration Wizard - Step 2 of 7 x

Connection \

Select a server and database. e

Source D atasource Target Datasource

Select a datasource to display Select a datasource to display

[? = any character, * = any String) [? = any character, * = any String)

| j_, SAMPLE_DATASOURCE (Oracle) || | ElCAPSAMP (IBM DB2LUW) N
__,_] m| SCOTTY [Microsoft SAL Server) ‘ j?';] DALLAST [DB2 Z/05) [ 1|
_fJ SCOTTV/SOLEXPRESS (Microsoft SOL| = _::?_'-J DALLASS (DB2 Z/05) =
;_-J TESTDSUSO1 (Microsoft SAL Server) _i.i-_] DALLASS [DB2Z/05)

i ._;!] TESTDSUSO1/MICROSOFTHHSSEE [ :_,"!] Datob25 (Oracle)

‘ jJTDHLABDBZM 3(IBM DB2 LUW) EfngatobvaU?tc (IBM DB2 LUW)

__] w TORLABORCL10G_1 [Oracle] :}] Datoelsie [Oracle)

: v*ll TORLABORCL10g 2 [Oracle] : S DATOERICAT [Microsoft SOL Server)
__,_]TDHLABSW 501_1 (Sybase ASE] (M) :‘_JDATDTB21 [Microsoft SOL Server) hedll
£ —T | 2 ||| [ ‘ , 12

N Fitvist [ Cancel ] [ Help ]

4. Select an Oracle datasource from the Source Datasource list and a Microsoft
SQL Server datasource from the Target Datasource list.
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5. Click Next and provide login credentials if prompted. DBArtisan opens the next
panel of the Migration Wizard.

Since Microsoft SQL Server supports multiple databases per datasource, you must
choose a database.

6. Select an entry from the Target Database list and then click Next. DBArtisan
opens the next panel of the Migration Wizard.

Migration Wizard - Step 4 of 7

Object Selection F AN
For each object type, select the objects that you wish to migrate. m

Object Types Objects
‘ [J+«}» Check Constraints [~
[Je% Clusters [
[[14% Configuration Parameters ‘
(1%, Database Links | =
[[Jum Directories i Al
[(]%% Foreign Keys
[(]&% Groups
[I[EE] Indexes
[CIES] Jobs ’
[(4h Libraries v

[ Select Al ] [ Unselect &ll ] Cancel Load

[ <Back || New> | | Fiish | [ Cancel | [ Hebp ]

7. In the Object Types list, select the object types to be migrated to the target
datasource.

As you select object types, the Objects list is updated to let you select specific objects
to migrate. The Expand/Collapse icons let you drill down through
dependencies/containment.

8. Use the Obijects list to select the specific objects to migrate.

9. Click Next. DBArtisan opens the next panel of the Migration Wizard.
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 Migration Wizard - Step 5 of 7 = ]
I Options
Choose your migration options.
!%g! % i bExample Preview
l EI_ E' - U:E adinuta 2
Group Dependencies 9 db |
Order Drops By Selection [ EIREATE TABLE dbo.ExamplePre»
= 2 =
e — order_id intNOT NULL, |
Script Create Statements i customer_id int NOT NULL, 3
{ Script Object Privileges 0l 3 tem_id  int NOT NULL,
Script System Privileges ) CONSTRAINT EXAMPLE_PK
Seript If Not Exists PRIMARY KEY (order_id)
Script Use Statement ) =
File Encoding ANSI (=] ON FieGroup2B
{{| = Owner Options go
Script Owner IF OBJECT_ID(N'dbo.ExamplePrS
Owner Retain Owner [ | PRINT N'<<< CREATED TAB ~
Change Owner To < | 1t | ,
Copy Owner [
o ] 1 R Ry p T ¥ - Save Options Template
] > Save Delete
[ Set as Defautt
< Back lM Finish Cancel Help

10. Examine the migration options offered but leave the default settings for now.
11. Click Next. DBArtisan opens the next panel of the Migration Wizard.
Clicking Finish executes the migration and lets you view the progress of the job.

Proceed to Session 8: Performance Management.
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Session 8: Performance Management

DBArtisan offers a number of different options to help you manage the performance of
your databases. First, DBArtisan ships with a built-in process monitor that helps you
understand who is connected to your database along with each user’s current activity
and session-related data. For more robust performance details, DBArtisan’s
Performance Analyst add-on is a powerful client-side database monitor that runs fully
contained in the DBArtisan console.

The following topics walk you through some of the performance management features:

o Monitoring Sessions

o Advanced Client-Side Performance Monitoring
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Monitoring Sessions

Monitoring Sessions

While this example is specific to Oracle the Process Monitor is available for all of the
supported platforms.

To start the DBArtisan Process Monitor:
1. On the Datasource Explorer, select any Oracle datasource.

2. From the Utilities menu, select Database Monitor.

<] i | (2]

The Database Monitor includes the following options and features:

= Highlight any session and any currently running SQL is displayed in the
lower pane.

= You can drill-down into a specific session to display session-level
statistical details, historical and current wait events along with a working
copy of the currently running SQL that can be copied to an ISQL for
Explain Plan generation.

= By using the Monitor dropdown options you can display more advanced
database-level monitoring data such as locks, blocking locks, hit ratio by
user, Top 20 SQL, etc.
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— 7 Monitor: | Processes
‘ Processes B
All Locks

Blocking Locks

Active Rollback Seaments
Data Dictionary Cache
Datafile 1j0

General Statistics

Hit Ratio By User

Latches

Library Cache

MTS Dispatcher Contention
MTS Server Contention
Open Cursors

Parallel Queries

SGA Detail

SGA Hit Ratios

SGA Summary

SGA Dynamic Components
Tablespace Ij0

Top Twenty SQL

Wait Events

3. Close the Database Monitor pane.

Proceed to Advanced Client-Side Performance Monitoring.

Embarcadero Technologies


http://docwiki.embarcadero.com/DBArtisan/2016/en/Advanced_Client-Side_Performance_Monitoring

Advanced Client-Side Performance Monitoring

Advanced Client-Side Performance
Monitoring

For advanced performance monitoring and management, DBArtisan’s optional
Performance Analyst provides intelligent diagnostic information and strong drill-down
details to help you get to the heart of any episode of performance degradation.
Performance Analyst integrates completely with DBArtisan so that you can fix any
performance problems with a few clicks of the mouse.

Note: Performance Analyst is available for Oracle, SQL Server, Sybase ASE and DB2 for
Unix, Windows, and Linux.

Note: Performance Analyst is a separately-licensed component. If you are not working
with an evaluation copy of DBArtisan or do not have a specific license, proceed to
Session 10: General Utilities and Tools. Contact your license administrator or your
Embarcadero representative about obtaining a license.

1. On the Datasource Explorer, select any Oracle datasource.

2. On the Analyst menu, select Performance Analyst. The Performance Analyst
opens in the DBArtisan workspace for the target datasource.

In addition to the Home page displayed initially, Performance Analyst presents several
pages of statistics. Page categories include Memory, I/O, Space, Objects, Users, and
OS. Each page contains several panes of related statistics, the Home page’s Key Ratio
Analysis pane, for example:

B Key Ratio Analysis D«Gﬂ

Efficiency Activity

A Buffer Cache Hit Ratio A Buffer Busy Wait Ratio 0.00 %

& Library Cache Hit Ratio 100.00 % A Rollback Contertion Ratio  0.00 %

& Dictionary Cache Hit Ratio 100.00 % & Latch Miss Ratio 0.00 %

A Memory Sort Ratio 100.00 % A Parallel Query Busy Ratio  0.00 %
Parse/Execute Ratio 100.00 % Free Shared Pool Percent 23.27 %

100 % A= ———————mm\-\F | A gt
95 % SO (AR NS | S
a0 % ;32
85 % i ol i suszma i se
80 9% -

0% -

19:50:00 19:55:00 19:50:00 19:55.00

Note the toolbar at the top of the Performance Analyst. It lets you navigate among the
Performance Analyst statistics pages.

fR Home S Memoy v [E1/0 ~ JJSpace v FoObjects v B Users ~ [R0OS ~
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3. Experiment with displaying the various pages available from the toolbar
dropdowns.

See the DBArtisan online help Performance Analyst topics for a detailed walkthrough of
all available features and functionality.

Proceed to Session 9: Capacity Management.
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Session 9: Capacity Management

Planning for the future of your critical databases used to be a difficult task. However,
DBArtisan’s optional Capacity Analyst tool makes it easy to understand where your
databases are today and where they are headed in the future. Capacity Analyst lets you
track key database metadata and performance metrics over time so you can perform
trend analysis on key areas like growth, object fragmentation, I/O and session load. Like
all of the Analyst Series products, Capacity Analyst runs fully contained within DBArtisan
S0 you have access to smart, built-in forecasting mechanisms that allow you to predict
when your databases run out of space and the ability to proactively manage your
storage assets, all from the same console.

Performance Analyst is available for DB2 for Unix, Windows, and Linux, Sybase ASE,
Oracle, and SQL Server.

1. On the Datasource Explorer, select any Oracle datasource.
2. From the Analyst menu, select Capacity Analyst.

Note: Capacity Analyst is a separately-licensed component. If you are not working with
an evaluation copy of DBArtisan or do not have a specific license, proceed to Session 10:
General Utilities and Tools. Contact your license administrator or your Embarcadero
representative about obtaining a license.

The Capacity Analyst opens in the DBArtisan workspace for the target Oracle

datasource.

'a:m.nko_.-goe.(mmrnmmamn ;gu

|~ Damums (W pote See Doh Awre  Cowebnet  Gedmats e o6 -
R TR T RN . cUSIHU. BRI uS .
A-@FuO S DXABRzY 1. ASTIEHE. "9 202 1ENZALDAR.
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See the relevant DBArtisan online help topics for a detailed walkthrough of all available
features and functionality.

Proceed to Session 10: General Utilities and Tools.
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Session 10: General Utilities and Tools

No evaluation of DBArtisan would be complete without a mention of the general utilities
and tools that are available across all of the supported platforms. The Utilities menu
offers primarily DBMS-specific operations while those offered on the Tools menu are
more generic.

Utilit'&s | ' loﬁ
g} |"%chema Extraction... ‘ [ﬁ ind in Files...
&% Schema Migration... i l’% Database Search...
&l Schema Publication. .. ‘ @ Script Execution Facility
8% Data Unload... B File Execution Facility
841 pataLoad... | €& Scheduler
8 Visual Diff...
El. Database Monitor | Tt
B Database Export... ' [Z]| Query Builder
Bg Database Import... SQL Profiler »
'@ TablefIndex Size Estimator
Archive Activity... = e f
: Ef",» Import Data
Backup Control File... .
: ; DBZ z/0OS Server Component Installation 4
Chained Row Analysis. ..
Free Space Deficit,.. j ODBC Administrator
3,9'1 Instance Configuration. .. cg DBtFormarcE CarEss
Maximum Extent Limits... 2
#
Pinned Code... 3 2Rl Fhe
Resource Cost... S8 Code Workbench
Session Information. .. 2 Customize...

Top Sessions...

The Utilities menu contains the more advanced DBArtisan features. The available menu
items are context-sensitive and version-specific for the selected datasource DBMS
platform. This example above shows the Utilities menu features that are available for
Oracle.

The Tools menu contains those features that are common across all DBMS platforms.
The example above shows the Tools menu features that are available for all supported
DBMS platforms. Note that if any other Embarcadero products are installed on your
client they will be available on the Tools menu.

All DBArtisan utilities and tools provide a common interface that walks you through all
input and execution requirements. All results are consistently presented so you can
easily move between features without effort or confusion.

Proceed to Session 11: Using Performance 1Q.
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Session 11: Using Performance 1Q

These query examples show the benefits and possibilities that Performance IQ provides
for identifying bottlenecks in a database. Performance 1Q helps you to take corrective
actions and see the results of the taken actions.

As an example, different queries are presented for showing how Performance 1Q works.

SQL Server

CPU Waits query

This query should be run against the target data source where we want to generate
load. The script takes 1-2 minutes and shows CPU waits consumption in the Top Waits
Window.

DECLARE @big AS BIGINT

SELECT @big = 0

WHILE @big < 300000000
SELECT @big = @big + 1

@ Top waits

40m
¥ m

B Otnar

W Memory
3 Lock

no

W ooy

acky

nam

Walt Tme

0100 Pu 0200 PM

SOL Procecures  Agoikatons

i repessa

Statament o Excuxns o Avp Eupsed(mc) ¢ Wi Thne vi. Hstory (se¢)

DECLARE @04 &5 bigirk SELECT @G = 0 WHILE @k « 200000000 SELECT @it = ity » 1 0 0,000 1002200
& 304278

Boen2
T
1843

20" 1) + (c3z0 S stale when 1 en 32 when 2 then 128 when & then ren & then 512 e O end) * {case S.5_rex %

T SUM (s00rt rows) FROM sys panitions spart WHE
=5 OR O Bpe IN (U, TTIAND O _ms_sooad <= 00 0
OM 575 Symmetic_keys AS ¢ WHERE (¢ symmetic_key_d < 101) ORDER BY ¢ name ASC 0

ot obyect_d = O.object_Jd AND spart ndex_id < 2). €)

T aties FROM 373 20_ctiects O WHERE (O
20

IO Scan

The 10 Scans.sgl script included in the .zip you can find below, runs 10 scans against the
largest tables in a database. It needs some large tables to show some relevant 10 wait
times and cleans out the buffer cache beforehand to ensure that the scans are always
done from disk.

In case you do not have any large tables, you can use the Northwind database (shipped
with SQL Server - it can also be downloaded). Once you have the Northwind database,
use the script Load suppliers Table For 10 Scans.sql included in the .zip file below.
This script makes special copies from Northwind to create a juicy big table to scan.

File:loScan.zip
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Blocking waits

In case you are not sure if the blocking waits are showing correctly the 2 scripts below
will give an accurate representation:

Run this script first:

IF (SELECT COUNT (*) FROM tempdb..sysobjects WHERE name = N'##BlockingTable') =

0
CREATE TABLE ##BlockingTable (
[SupplierID] [INT] NOT NULL
) ON [PRIMARY]
GO

BEGIN TRANSACTION

SELECT COUNT (*) FROM ##BlockingTable (TABLOCKX)
WAITFOR DELAY '00:03:02'

COMMIT TRANSACTION

2-3 seconds after that script starts running you can start to run the script below in
another query window (or job). This second script will be blocked for almost 3 minutes
by the first script. This should show up on Top Waits Window as a 3 minutes block wait.

SELECT COUNT (*) FROM ##BlockingTable (TABLOCKX)
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Other Wait Types

This simple statement runs for 10 minutes and shows a 10 minutes WAITFOR type wait.

WAITFOR DELAY '00:10:00"
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+ SELECT COUNT(") FROM eiicciong Tatim (TABLOCKX) W

o SELECT getutccate() INTERVAL_TIME. CONVERT( NVARCHAR(B4), £53(_hancse, 1) = *_* + CONVERT{ NVARCHAR(10), COALESCE( g statement_start_ofiset2, 0) ) SOL_ID, CC had
WAITFOR DELAY 001000

 SELECT COUNT(") FROM mWBiociong Tabie (TASLOCKX)

@ SOL Detaiis

5o Ter FS0L Detais
WAITFOR DELAY 00 10:00°

Quantity of statements
The SQL below creates 10,000 different SQL Statements in a very short period.

On a "clean™ monitored DBMS server, they should show up as different statements.

What this SQL is designed to do is create a huge amount of background noise on a
DBMS.
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SET NOCOUNT ON
DECLARE @SQL nvarchar (1024)
DECLARE @COUNT INT
SELECT @COUNT = 1
WHILE @COUNT < 10000
BEGIN
SELECT @COUNT = @COUNT + 1

SELECT @Counter = COUNT (*) FROM master..sysprocesses WHERE '
RAND () *2000000)

EXEC (Q@SQL)
END

+

CONVERT (VARCHAR (20) , RAND()*1000000) + N' <> ' + CONVERT (VARCHAR (20),

SELECT @SQL = N'WAITFOR DELAY ''00:00:00.007'' DECLARE @Counter int

(Top Walts|| Top o | Miests | 44 4 B8 - D PP B - towkast3 Howes) -
= SELECT @Courter = COUNT(") FROM mastee_syssrocesses WHERE 301773 o 273443
2'IINWOR DELAY 00:00:00 007 DECLARE @Counter int SELECT @Counter = COUNT(") FROM mastersysprocesses WHERE 7316493 < 803457
2 WAITFOR DELAY 00,0000 00T DECLARE @Coumter it SELECT @Cournae = COUNT() FROM matee. sysceocesses WHERE $19778 <= 374174
S SELECT @Counter = COUNT(') FROM mastor $ysgrocesses WHERE 402225 <> 10246204008
2WA:'IFDR DCELAY 00 00:00 007 DECLARE @Counter it SELECT @Counter » COUNT(") FROM master $y50r0cesses WHERE 273315 « 1.960860~005
2 SELECT @Countier = COUNT(') FROM master_sysgrocesses WHERE 533048 < 655030
= SELECT @Courne = COUNT(") FROM mastie. $y3geocesses WHERE 177471 «» 960692
2 SELECT §Counter = COUNT(") FROM mastis sysprocesses WHERE 233015 <= 1 X084 30+008
‘:SELECY @Counter » COUNT(") FROM master $y5000ceases WHERE 577277 <> 1167070008
2 SELECT @Counn = COUNT(") FROM mastiv $y400cesses WHERE 950610 < 670414
i SELECT @Counter = COUNT(") FROM master_sysgrocesses WHERE 671823 © 653515
S SELECT @Counter = COUNT(") FROM mister_sysorosesses WHERE 520030 « 553630
232LECT GCounter = COUNT(") FROM master_ syscrocesses WHERE 722003 © 977729
S WAITFOR DELAY 0010000007 DECLARE @Couster int SELECT @Courtt = COUNT(") FROM mastie. sysrocedses WHERE ST7277 < 11670702005
2 WATFOR DELAY D0:00:00 007 DECLARE @Counter int SELECT @Counter = COUNT(') FROM master sysgrocesses WHERE 472702 < 567205
2'NNTFOR DELAY 000000 007 DECLARE @Counter it SELECT @Counter « COUNT(") FROM master sysprocesses WHERE £05102 © 1.337340+005
2 SELECT @Counter = COUNT(") FROM master syssrocesses WHERE 483318 < 314953
= SELECT @Couran = COUNT() FROM mastie $y3¢eocesses WHERE 212412 «» 202092
2 SELECT @Cournst = COUNT(') FROM mistee. syicrocesses WHERE 921545 < 10574
i SELECT @Counter » COUNT(') FROM mastir syscrocesses WHERE 255647 © 1 34420+008
= WAITFCR DELAY DX0X00 007" DECLARE @Counter ¢ SELECT @Courmsr » COUNT(") FROM master sy52rceesses WHERE 210116 <> 650014
+ SELECT SC name, O name, | name, DS name FROM sys otjects O JOIN sy schemas SC ON O schema_id = SC.schema_id JOIN sys indexes | ON O object_id=t odject_id AND s,
3 SELECT @Couran = COUNT() PROM mastie_syserocesses WHERE 817250 <= 642954
2 SELECT @Counnir = COUNT(') FROM mastee_syisrocesses WHERE 463746 <= 1 450154000
2 WATTFOR DELAY 000000 00T DECLARE @Counter it SELECT @Cournar « COUNT(") FROM mastie sysgrocesses WHERE 621538 < 1022280+005
& SELECT @Counter = COUNT(") FROM master sysgrocesses WHERE §63406 < 1 4630204005
= SELECT @Countor = COUNT(") FROM mastersysorocesses WHERE 158252 © 319545
3 SELECT @Countne = COUNTI') FROM master.syssrocesses WHERE 278156 <» 1083540008
% SELECT @Countnr » COUNT(") FROM master. syserocedses WHERE 330807 < 1,103784+005
S SELECT @Countne = COUNTC') FROM mastie syscrocessas WHERE 937338 < 152817
SSELECY @Counter = COUNT(*) FROM master syscrocesses WHERE 325845 © 529908
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